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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 

MPLAB ICD 3 in-circuit debugger. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Warranty Registration

• Recommended Reading

• The Microchip Web Site

• Development Systems Customer Change Notification Service

• Customer Support

• Revision History

DOCUMENT LAYOUT

This document describes how to use the MPLAB ICD 3 in-circuit debugger as a 

development tool to emulate and debug firmware on a target board, as well as how to 

program devices. The document is organized as follows:

Part 1 – Getting Started

• Chapter 1. Overview – What the MPLAB ICD 3 in-circuit debugger is, and how it 

can help you develop your application.

• Chapter 2. Theory of Operation – The theory of MPLAB ICD 3 in-circuit debug-

ger operation. Explains configuration options.

• Chapter 3. Installation – How to install the debugger software and hardware.

• Chapter 4. General Setup – How to set up MPLAB IDE to use the debugger.

• Chapter 5. Tutorial – A brief tutorial on using the debugger.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 

documentation are constantly evolving to meet customer needs, so some actual dialogs 

and/or tool descriptions may differ from those in this document. Please refer to our web site 

(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 

page, in front of the page number. The numbering convention for the DS number is 

“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 

document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 

Select the Help menu, and then Topics to open a list of available on-line help files.
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Part 2 – Troubleshooting

• Chapter 6. Frequently Asked Questions (FAQs) – A list of frequently asked 

questions, useful for troubleshooting.

• Chapter 7. Error Messages – A list of error messages and suggested 

resolutions.

Part 3 – Reference

• Chapter 8. Basic Debug Functions – A description of basic debugger features 

available in MPLAB IDE when the MPLAB ICD 3 in-circuit debugger is chosen as 

either the debug or programming tool. This includes the debug features 

breakpoints, stopwatch, triggering and real-time watches.

• Chapter 9. Debugger Function Summary – A summary of debugger functions 

available in MPLAB IDE when the MPLAB ICD 3 debugger is chosen as the 

debug or program tool.

• Chapter 10. Hardware Specification – The hardware and electrical 

specifications of the debugger system.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 

dialog

“Save project before build”

Underlined, italic text with 

right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 

where N is the total number of 

digits, R is the radix and n is a 

digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 

any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 

character: { | }

Choice of mutually exclusive 

arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 

user

void main (void)
{ ...
}
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WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. 

Sending in the Warranty Registration Card entitles users to receive new product 

updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user's guide describes how to use MPLAB ICD 3 in-circuit debugger. Other useful 

documents are listed below. The following Microchip documents are available and 

recommended as supplemental reference resources.

Please read this first! This document contains important information about operational 

issues that should be considered when using the MPLAB ICD 3 with your target 

design

Release Notes for MPLAB ICD 3 In-Circuit Debugger

For the latest information on using MPLAB ICD 3 in-circuit debugger, read the 

“Readme for MPLAB ICD 3 Debugger.htm” file (an HTML file) in the Readmes 

subdirectory of the MPLAB IDE installation directory. The release notes (Readme) 

contains update information and known issues that may not be included in this user’s 

guide.

Using MPLAB ICD 3 In-Circuit Debugger Poster (DS51765)

This poster shows you how to hook up the hardware and install the software for the 

MPLAB ICD 3 in-circuit debugger using standard communications and a target board.

MPLAB ICD 3 In-Circuit Debugger On-line Help File

A comprehensive help file for the debugger is included with MPLAB IDE. Usage, 

troubleshooting and hardware specifications are covered. This may be more up-to-date 

than the printed documentation. Also, debugger reserved resources and limitations are 

listed for various devices.

Header Board Specification (DS51292)

This booklet describes how to install and use MPLAB ICD 3 in-circuit debugger 

headers. Headers are used to better debug selected devices using special -ICE device 

versions without the loss of pins or resources.

Transition Socket Specification (DS51194)

Consult this document for information on transition sockets available for use with 

MPLAB ICE 2000/4000 device adaptors, MPLAB ICD 2 headers and MPLAB ICD 3 

in-circuit debugger headers.
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THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 

site is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the web site contains the following 

information:

• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 

latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 

support requests, online discussion groups, Microchip consultant program 

member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 

press releases, listing of seminars and events, listings of Microchip sales offices, 

distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 

products. Subscribers will receive e-mail notification whenever there are changes, 

updates, revisions or errata related to a specified product family or development tool of 

interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 

Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB C compilers; all MPLAB 

assemblers (including MPASM™ assembler); all MPLAB linkers (including 

MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object 

librarian).

• Emulators – The latest information on Microchip in-circuit emulators.These 

include the MPLAB REAL ICE™, MPLAB ICE 2000 and MPLAB ICE 4000 

in-circuit emulators

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 

debuggers, the MPLAB ICD 2 in-circuit debugger and PICkit™ 2 debug express.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 

Integrated Development Environment for development systems tools. This list is 

focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 

MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 

the MPLAB PM3 and PRO MATE II device programmers and the PICSTART® 

Plus and PICkit 1 and 2 development programmers.
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers. A listing of 

sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com.

REVISION HISTORY

Revision A (September 2008)

This is the initial release of this document.
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Chapter 1.  Overview

1.1 INTRODUCTION

An overview of the MPLAB ICD 3 in-circuit debugger system is given.

• MPLAB ICD 3 In-Circuit Debugger Defined

• How the MPLAB ICD 3 In-Circuit Debugger Helps You

• MPLAB ICD 3 In-Circuit Debugger Kit Components

• Device and Feature Support

1.2 MPLAB ICD 3 IN-CIRCUIT DEBUGGER DEFINED

The MPLAB ICD 3 in-circuit debugger is an in-circuit debugger that is controlled by a 

PC running MPLAB IDE (v8.15 or greater) software on a Windows® platform. The 

MPLAB ICD 3 in-circuit debugger is an integral part of the development engineer's 

toolsuite. The application usage can vary from software development to hardware 

integration.

The MPLAB ICD 3 in-circuit debugger is a complex debugger system used for 

hardware and software development of Microchip PIC® microcontrollers (MCUs) and 

dsPIC® Digital Signal Controllers (DSCs) that are based on In-Circuit Serial 

Programming™ (ICSP™) and Enhanced In-Circuit Serial Programming 2-wire serial 

interfaces.

The debugger system will execute code like an actual device because it uses a device 

with built-in emulation circuitry, instead of a special debugger chip, for emulation. All 

available features of a given device are accessible interactively, and can be set and 

modified by the MPLAB IDE interface.

The MPLAB ICD 3 debugger was developed for emulating embedded processors with 

rich debug facilities which differ from conventional system processors in the following 

aspects:

• Processors run at maximum speeds

• Capability to incorporate I/O port data input

In addition to debugger functions, the MPLAB ICD 3 in-circuit debugger system also 

may be used as a development programmer.



MPLAB® ICD 3 In-Circuit Debugger User’s Guide

DS51766A-page 10 © 2008 Microchip Technology Inc.

1.3 HOW THE MPLAB ICD 3 IN-CIRCUIT DEBUGGER HELPS YOU

The MPLAB ICD 3 in-circuit debugger system allows you to:

• Debug your application on your own hardware in real time

• Debug with hardware breakpoints

• Debug with software breakpoints

• Set breakpoints based on internal events

• Monitor internal file registers

• Emulate full speed

• Program your device

1.4 MPLAB ICD 3 IN-CIRCUIT DEBUGGER KIT COMPONENTS

The components of the MPLAB ICD 3 in-circuit debugger system kit are:

1. MPLAB ICD 3 with indicator lights

2. USB cable to provide communications between the debugger and a PC and to 

provide power to the debugger

3. Cable (also MPLAB ICD 2 compatible) to connect the MPLAB ICD 3 to a header 

module or target board

4. MPLAB IDE Quick Start Guide (DS51281)

5. CD-ROM with MPLAB IDE software and on-line documentation

6. ICD 3 Test Interface Board

FIGURE 1-1: BASIC DEBUGGER SYSTEM

Additional hardware that may be ordered separately:

• Transition socket

• ICD headers

• MPLAB processor extension kits

MPLAB® ICD 3

Modular Cable
to Target Board

USB Cable to PC

Indicator
Lights

or Header
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1.5 DEVICE AND FEATURE SUPPORT

Table 1-1 and Table 1-2 show the current and future support for devices and device 

features.

TABLE 1-1: 32-BIT AND 16-BIT (DATA MEMORY) DEVICES

Feature PIC32MX
 dsPIC33F, 

PIC24F/H

dsPIC30F 

SMPS(1) dsPIC30F

Reset application C C C C

Run, Halt C C C C

Single Step C C C C

Animate C C C C

Full Speed Emulation C C C C

Hardware Breakpoints C C C C

Advanced Breakpoints C C C C

Software Breakpoints N C C C

Peripheral Freeze(2) C C C C

Break on data fetch or write C C C C

Break on Stack overflow C C C C

Stopwatch C C C N

Pass Counter C C C C

WDT overflow C C C N

Standard Speed Comm. C C C C

Processor Pak N F F N

Legend:

C = Current support

D = Support dependent on device 

F = No support now, but planned in the future

N = Support Not Available

Note 1: Current Switch Mode Power Supply (SMPS) devices: dsPIC30F1010/2020/2023.

2: This feature operates differently depending on the selected device.



MPLAB® ICD 3 In-Circuit Debugger User’s Guide

DS51766A-page 12 © 2008 Microchip Technology Inc.

TABLE 1-2: 8-BIT (DATA MEMORY) DEVICES

Feature PIC18FXXJ

PIC18F,

PIC18F Enh, 

PIC18FXXK

PIC12F, PIC16F

Reset application C C C

Run, Halt C C C

Single Step C C C

Animate C C C

Full Speed Emulation C C C

Hardware Breakpoints C C C

Advanced Breakpoints C C N

Software Breakpoints C C N

Peripheral Freeze(1) C C C

Break on data fetch or write C C N

Break on Stack overflow C C N

Stopwatch C N N

Pass Counter C C N

WDT overflow C N N

Standard Speed Comm. C C C

Processor Pak F F F

Legend:

C = Current support

F = No support now, but planned in the future

N = Support Not Available

Note 1: This feature operates differently depending on the selected device.
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Chapter 2.  Theory of Operation

2.1 INTRODUCTION

A simplified description of how the MPLAB ICD 3 in-circuit debugger system works is 

provided here. It is intended to provide enough information so a target board can be 

designed that is compatible with the debugger for both emulation and programming 

operations. The basic theory of in-circuit emulation and programming is described so 

that problems, if encountered, are quickly resolved.

• MPLAB ICD 3 In-Circuit Debugger vs. MPLAB ICE 2000/4000 In-Circuit 

Emulators

• MPLAB ICD 3 In-Circuit Debugger vs. MPLAB ICD 2 Debugger

• Debugger To Target Communication

• Communication Connections

• Debugging with the Debugger

• Requirements For Debugging

• Programming with the Debugger

• Resources Used by the Debugger

2.2 MPLAB ICD 3 IN-CIRCUIT DEBUGGER VS. MPLAB ICE 2000/4000 
IN-CIRCUIT EMULATORS

The MPLAB ICD 3 in-circuit debugger system is a next generation In-Circuit Debugger 

(ICD) system. It differs from classical in-circuit emulator systems (e.g., MPLAB ICE 

2000/4000) in a single, but important way: the production device and emulation device 

are the same. 

This is a great benefit since differences (errata) between the production silicon and 

emulation silicon are eliminated. Additionally, as devices continue to operate at faster 

speeds, traditional emulator systems present bottlenecks caused by internal busses 

that must be carried off-chip to external memories and cannot offer full speed 

emulation.

Another significant benefit is that there is no lead time between production silicon and 

emulation silicon. Further, a problem encountered on a production board can be easily 

debugged without having to install transition sockets and dealing with complicated 

cabling systems and setups to have access to the application.

2.3 MPLAB ICD 3 IN-CIRCUIT DEBUGGER VS. MPLAB ICD 2 DEBUGGER

The MPLAB ICD 3 in-circuit debugger system is similar in function to the MPLAB ICD 

2 in-circuit debugger system, but surpasses it in speed and functionality. The MPLAB 

ICD 3 also: 

• Features USB high speed

• Is USB powered

• Is a hardware accelerator

• Provides a programmable voltage power supply

• Eliminates the RS-232 port

• Includes a diagnostic self-test interface board
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2.4 DEBUGGER TO TARGET COMMUNICATION

The debugger system configurations are discussed in the following sections.

Standard ICSP Device Communication

The debugger system can be configured to use standard ICSP communication for both 

programming and debugging functions. This 6-pin connection is the same one used by 

the MPLAB ICD 2 in-circuit debugger.

The modular cable can be either (1) inserted into a matching socket at the target, where 

the target device is on the target board (Figure 2-1), or (2) inserted into a standard 

adapter/header board combo (available as a Processor Pak), which in then plugged 

into the target board (Figure 2-2).

For more on standard communication, see Chapter 10. “Hardware Specification”.

FIGURE 2-1: STANDARD DEBUGGER SYSTEM – DEVICE WITH 

ON-BOARD ICE CIRCUITRY

CAUTION

Do not connect the hardware before installing the software and USB drivers. Also, do 

not change hardware connections when the pod or target is powered.

Note: Older header boards used a 6-pin (RJ-11) connector instead of an 8-pin 

connector, so these headers may be connected directly to the debugger.

MPLAB® ICD 3

Target Board

Target Device
or PIM

Power
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FIGURE 2-2: STANDARD DEBUGGER SYSTEM – ICE DEVICE

2.5 COMMUNICATION CONNECTIONS

2.5.1 Standard Communication Target Connection

Using the RJ-11 connector, the MPLAB ICD 3 in-circuit debugger is connected to the 

target device with the modular interface (six conductor) cable. The pin numbering for 

the connector is shown from the bottom of the target PC board in Figure 2-3. 

FIGURE 2-3: STANDARD CONNECTION AT TARGET

2.5.2 Target Connection Circuitry

Figure 2-4 shows the interconnections of the MPLAB ICD 3 in-circuit debugger to the 

connector on the target board. The diagram also shows the wiring from the connector 

to a device on the target PC board. A pull-up resistor (usually around 10 kΩ) is 

recommended to be connected from the VPP/MCLR line to VDD so that the line may be 

strobed low to reset the device.
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Note: Cable connections at the debugger and target are mirror images of each 

other, i.e., pin 1 on one end of the cable is connected to pin 6 on the other 

end of the cable. See Section 10.6.2.3 “Modular Cable Specification”.
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FIGURE 2-4: STANDARD CONNECTION TARGET CIRCUITRY

2.5.3 Target Powered

In the following descriptions, only three lines are active and relevant to core debugger 

operation: pins 1 (VPP/MCLR), 5 (PGC) and 4 (PGD). Pins 2 (VDD) and 3 (VSS) are 

shown on Figure 2-4 for completeness. MPLAB ICD 3 has two configurations for 

powering the target device: internal debugger and external target power.

The recommended source of power is external and derived from the target application. 

In this configuration, target VDD is sensed by the debugger to allow level translation for 

the target low voltage operation. If the debugger does not sense voltage on its VDD line 

(pin 2 of the interface connector), it will not operate.

2.5.4 Debugger Powered

The internal debugger power is limited in two aspects: (1) the voltage range is not as 

wide (3-5V); and (2) the amount of current it can supply is limited to 100 mA. This may 

be of benefit for very small applications that have the device VDD separated from the 

rest of the application circuit for independent programming, but is not recommended for 

general usage as it imposes more current demands from the USB power system 

derived from the PC.

Be aware that the target VDD is sensed by the debugger to allow level translation for 

target low-voltage operation. If the debugger does not sense voltage on its VDD line (pin 

2 of the interface connector), it will not operate.

Not all devices have the AVDD and AVSS lines, but if they are present on the target 

device, all must be connected to the appropriate levels in order for the debugger to 

operate.

In general, it is recommended that all VDD/AVDD and VSS/AVSS lines be connected to 

the appropriate levels. Also, devices with a VCAP line (PIC18FXXJ for example) should 

be connected to the appropriate capacitor or level.
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Note: The interconnection is very simple. Any problems experienced are often 

caused by other connections or components on these critical lines that 

interfere with the operation of the MPLAB ICD 3 in-circuit debugger system, 

as discussed in the following section.
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2.5.5 Circuits That Will Prevent the Debugger From Functioning

Figure 2-5 shows the active debugger lines with some components that will prevent the 

MPLAB ICD 3 in-circuit debugger system from functioning.

FIGURE 2-5: IMPROPER CIRCUIT COMPONENTS

Specifically, these guidelines must be followed:

• Do not use pull-ups on PGC/PGD – they will disrupt the voltage levels, since 

these lines have 4.7 kΩ pull-down resistors in the debugger.

• Do not use capacitors on PGC/PGD – they will prevent fast transitions on data 

and clock lines during programming and debug communications.

• Do not use capacitors on MCLR – they will prevent fast transitions of VPP. A 

simple pull-up resistor is generally sufficient.

• Do not use diodes on PGC/PGD – they will prevent bidirectional communication 

between the debugger and the target device.

2.6 DEBUGGING WITH THE DEBUGGER

There are two steps to using the MPLAB ICD 3 in-circuit debugger system as a 

debugger. The first requires that an application be programmed into the target device. 

The second uses the internal in-circuit debug hardware of the target Flash device to run 

and test the application program. These two steps are directly related to the MPLAB 

IDE operations:

1. Programming the code into the target and activating special debug functions 

(see the next section for details).

2. Using the debugger to set breakpoints and run.

If the target device cannot be programmed correctly, the MPLAB ICD 3 in-circuit 

debugger will not be able to debug.

Figure 2-6 shows the basic interconnections required for programming. Note that this 

is the same as Figure 2-4, but for the sake of clarity, the VDD and VSS lines from the 

debugger are not shown.
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FIGURE 2-6: PROPER CONNECTIONS FOR PROGRAMMING 

A simplified diagram of some of the internal interface circuitry of the MPLAB ICD 3 

in-circuit debugger is shown. For programming, no clock is needed on the target 

device, but power must be supplied. When programming, the debugger puts 

programming levels on VPP/MCLR, sends clock pulses on PGC and serial data via 

PGD. To verify that the part has been programmed correctly, clocks are sent to PGC 

and data is read back from PGD. This conforms to the ICSP protocol of the device 

under development.

2.7 REQUIREMENTS FOR DEBUGGING

To debug (set breakpoints, see registers, etc.) with the MPLAB ICD 3 in-circuit 

debugger system, there are critical elements that must be working correctly:

• The debugger must be connected to a PC. It must be powered by the PC via the 

USB cable, and it must be communicating with the MPLAB IDE software via the 

USB cable. See Chapter 3. “Installation” for details.

• The debugger must be connected as shown to the VPP, PGC and PGD pins of the 

target device with the modular interface cable (or equivalent). VSS and VDD are 

also required to be connected between the debugger and target device.

• The target device must have power and a functional, running oscillator. If the 

target device does not run, for any reason, the MPLAB ICD 3 in-circuit debugger 

cannot debug.

• The target device must have its configuration words programmed correctly:

- The oscillator Configuration bits should correspond to RC, XT, etc., depending 

upon the target design.

- For some devices, the Watchdog Timer is enabled by default and needs to be 

disabled.

- The target device must not have code protection enabled.

- The target device must not have table read protection enabled.

• LVP should be disabled.

Once the above conditions are met, you may proceed to the following:

• Sequence of Operations Leading to Debugging

• Debugging Details

2.7.1 Sequence of Operations Leading to Debugging

Given that the Requirements For Debugging are met, these actions can be performed 

when the MPLAB ICD 3 in-circuit debugger is set as the current debugger from the 

MPLAB IDE menu (Debugger>Select Tool>MPLAB ICD 3):

• The application code is compiled/assembled by selecting Project>Build 
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Configuration>Debug.

• When Debugger>Program is selected, the application code is programmed into 

the device’s memory via the ICSP protocol as described above.

• A small “debug executive” program is loaded into the high area of program 

memory of the target device. Since the debug executive must reside in program 

memory, the application program must not use this reserved space. Some devices 

have special memory areas dedicated to the debug executive. Check your device 

data sheet for details.

• Special “in-circuit debug” registers in the target device are enabled. These allow 

the debug executive to be activated by the debugger.

• The target device is held in Reset by keeping the VPP/MCLR line low.

2.7.2 Debugging Details

Figure 2-7 illustrates the MPLAB ICD 3 in-circuit debugger system when it is ready for 

debugging.

FIGURE 2-7: MPLAB® ICD 3 IN-CIRCUIT DEBUGGER READY FOR 

DEBUGGING

Typically, in order to find out if an application program will run correctly, a breakpoint is 

set early in the program code. When a breakpoint is set from the user interface of 

MPLAB IDE, the address of the breakpoint is stored in the special internal debug 

registers of the target device. Commands on PGC and PGD communicate directly to 

these registers to set the breakpoint address.

Next, the Debugger>Run function or the Run icon (forward arrow) is usually pressed 

from MPLAB IDE. The debugger will then tell the debug executive to run. The target 

will start from the Reset vector and execute until the Program Counter reaches the 

breakpoint address previously stored in the internal debug registers.

After the instruction at the breakpoint address is executed, the in-circuit debug 

mechanism of the target device “fires” and transfers the device’s Program Counter to 

the debug executive (much like an interrupt) and the user’s application is effectively 

halted. The debugger communicates with the debug executive via PGC and PGD, gets 

the breakpoint status information and sends it back to MPLAB IDE. MPLAB IDE then 

sends a series of queries to the debugger to get information about the target device, 

such as file register contents and the state of the CPU. These queries are ultimately 

performed by the debug executive.
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